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Getting Started 

Welcome 

Welcome to the Firmware Management Console (FMC).  FMC is designed to update firmware in IP7 IP 
Endpoints.  Updated firmware adds new features to IP Endpoints or corrects reported issues. 

Release Notes 

V6.0 Release June 2018 

 Added menu option Search --> Search IP Endpoint List and keyboard equivalent ctrl+f

 Added Update WiFi Firmware option for new Wireless IP7 Endpoints (available Q3 2018)

 Improved the performance of the main list box when connecting hundreds of IP Endpoints

V5.2.1 Release June 2016 

 Added the display of the Zone Controller firmware version on an IP7-MZC

 Added the ability to update the Zone Controller firmware on an IP7-MZC

January 2012 

 Initial Release designed to updated firmware for multiple IP7 endpoints

Logon 

The Logon Required dialog is displayed when the FC is started.  Logon using the default admin Operator 
ID or an Operator that has been defined with the Administrator Rights option in the Admin Console .   

 Logon ID - Identifies the Operator defined to the TalkMaster Focus Server through the Admin
Console. Please Note - the Operator must be defined in the Admin Console with the
Administrator Rights option in order to use the FC.  An Operator can only be logged on to a
single console at a time

 Password - Enter the corresponding Operator's password. This field is case sensitive.

 Login - Click to process the login information



TalkMasterFOCUSFirmwareManagementConsoleReferenceManual 

2 

 Cancel - Click to cancel the logon operation

 Options - Click to toggle the display of the Address information

o Address - enter the IP address and Port that Consoles use to connect to the TalkMaster
Focus Server. The port must match the Console Port defined in the Setup --> Settings
sub tab of the Admin Console.  Once the TalkMaster Focus Server address has been
entered, the Address will not be displayed

Overview 

The Firmware Console lists all IP Endpoints that are currently connected to the TalkMaster Focus Server. 
 If additional IP Endpoints are on the network, but not connected to the TalkMaster Focus Server, they 
can be discovered on the network by pressing the Find All button.  To update the firmware on one or 
more IP Endpoints, place a check in the Grp column and press the Update IP7 Firmware, Update ZC 
Firmware, or Update WiFi Firmware button.   
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 Grp - Check this box to include an IP Endpoint in the firmware update process

 Location - Displays the friendly name of the IP Endpoint

 Icom ID - Displays the ICOM ID of the IP Endpoint.  The ICOM ID is the unique MAC address of
the IP Endpoint.  The ICOM ID is printed on the IP Endpoint and is used to identify it to the
software

 Status - The status is used to determine if the IP Endpoint can be discovered by the TalkMaster
Focus Server.  For instance, if an IP Endpoint that is configured to connect to the TalkMaster
Focus Server is offline, it will appear as Unavailable

 Address - Displays the IP Address of the IP Endpoint

 Type - Displays the current firmware version of the endpoint

Find All button - Press this button to discover any IP Endpoints that are not currently connected to
the TalkMaster Focus Server

Update WiFi Firmware button  - Press this button to update the wireless firmware on any IP
Endpoints that have the Grp box checked.  This action is described in the IP7 Firmware Update
Process

Update ZC Firmware button  - Press this button to update the Zone Controller firmware on any IP
Endpoints that have the Grp box checked.  This action is described in the ZC Firmware Update
Process

Update IP7 Firmware button  - Press this button to update the firmware on any IP Endpoints that
have the Grp box checked.  This action is described in the IP7 Firmware Update Process
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Updating Firmware 

IP7 Firmware Update Process 

For IP Endpoints with Firmware version 6 or greater that are currently connected to the TalkMaster 
FOCUS Server, the Firmware is sent to the IP Endpoint via the existing TCP connection.  These IP 
Endpoints can always be updated via the Firmware Console since its existing TCP connection is used. 

For IP Endpoints with Firmware version prior to version 6 or any IP Endpoint that is not currently 
connected to the TalkMaster Focus Server:  

 A UDP command is sent from the TalkMaster Focus Server to the IP Endpoint

 The IP Endpoint begins listening for a new TCP connection from the TalkMaster Focus Server

 The TalkMaster Focus Server connects to the endpoint

 The Firmware is sent to the IP Endpoint

 If a NAT'd firewall is between the IP Endpoint and the TalkMaster Focus Server, the Firmware
update will not work.  The software must be installed on a PC behind the NAT'd firewall and the
FC must be run from there to update the firmware

The Firmware Update is a multi step process: 

 The Firmware is downloaded to a memory chip on the IP Endpoint

 The firmware is verified to ensure the integrity of the download.  If this step fails, the firmware
update is aborted

 The IP Endpoint copies the firmware from the memory chip to the ROM on the microprocessor

 The IP Endpoint reboots using the new firmware

Update button 

The Update IP7 Firmware button is used to select the firmware to be sent to all IP Endpoints that have 
the Grp column checked.  
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Once the file is selected, the main screen is displayed and the firmware will be downloaded to the 
selected IP Endpoints.   
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The Status column will show the percent completion of the firmware download.  After the download 
completes, the Firmware update takes about 45 seconds on the IP Endpoints.  Do not disconnect the 
power from the IP Endpoint during this time or it may become unusable. The endpoint will not be 
available to any other Consoles till the Firmware Update completes. 

Firmware versions prior to 5.3.4.9 have some issues, which occur randomly, making it difficult to 
update the firmware on some IP7s.   

ZC Firmware Update Process 

For IP-MZC (Multi Zone Controller) Endpoints that are currently connected to the TalkMaster FOCUS 
Server, the Zone Controller Firmware is sent to the IP Endpoint via the existing TCP connection.  These 
IP Endpoints can always be updated via the Firmware Console since its existing TCP connection is used. 

To check the existing ZC Version, right click on the endpoint: 
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The Zone Controller has two areas for storing Firmware.  The Main area stores the code that was 
originally flashed at the factory.  The second area is the Update area that stores updated Zone Controller 
Code.  When the Update ZC Firmware button is pressed, the IP7 accepts the ZC Firmware and writes to 
the ZC's Update Area.  The Zone Controller always starts up in the Main Area and branches to the 
Update area if it is present.  

If the IP7-MZC is not currently connected to the TalkMaster FOCUS Server, the Zone Controller 
firmware cannot be updated. 

Update ZC Firmware 

The IP7-MZC - Multi Zone Controller may require a firmware update to enable new features or to correct 
reported issues.  The Update ZC Firmware button is used to select the firmware to be sent to all IP 
Endpoints that have the Grp column checked.  
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After selecting the firmware file, the update will be downloaded and the IP7 will reboot.  Press the FIND 
ALL button again and then right click on the IP Endpoint to verify the ZC Firmware Version. 

Please Note that to update the ZC Firmware, the IP7-MZC must be connected to the same TalkMaster 
FOCUS Server that the Firmware Management Console is connected to. 

WiFI Firmware Update Process 

For IP7s that support wireless network connections that are currently connected to the TalkMaster 
FOCUS Server, the WiFi Firmware is sent to the IP Endpoint via the existing TCP connection.  These IP 
Endpoints can always be updated via the Firmware Console since its existing TCP connection is used.    

To check the existing WiFi Version, right click on the endpoint: 
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There are two types of WiFi updates.  Application updates are the most common and less than a minute 
to complete. Image updates are much less frequently and take about 3 minutes to complete. 

If the wireless IP7 is not currently connected to the TalkMaster FOCUS Server, the WiFi firmware 
cannot be updated. 

Update WiFi Firmware 

Wireless IP7s may require a firmware update to enable new features or to correct reported issues.  The 
Update WiFi Firmware button is used to select the firmware to be sent to all IP Endpoints that have the 
Grp column checked.  
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After selecting the firmware file, the update will be downloaded and the IP7 will reboot.  Press the FIND 
ALL button again and then right click on the IP Endpoint to verify the ZC Firmware Version. 

Please Note that to update the ZC Firmware, the IP7-MZC must be connected to the same TalkMaster 
FOCUS Server that the Firmware Management Console is connected to. 

Find All button 

The FIND ALL button is used to discover IP Endpoints that are not currently connected to the TalkMaster 
Focus Server.  When the Find All button is pressed, the TalkMaster Focus Server does the following: 

 A UDP Multicast packet is sent to the registered multicast address of 224.0.23.59

 A UDP Broadcast packet is sent to IP Address 255.255.255.255

If an IP Endpoints receives the discovery packet, it responds as follows: 

 If the discovery packet has been received and the endpoint is currently "connected" to the
TalkMaster Focus Server, a response is returned to the IP Address of the sender

 If the discovery packet has been received and the endpoint is not currently "connected" to the
TalkMaster Focus Server, a response is returned to the IP Address of the sender and to the
Broadcast IP Address 255.255.255.255

If an IP Endpoint is in a different subnet than the TalkMaster Focus Sever and does not have a valid 
IP Address for that subnet, it will not be discovered.  Reset the endpoint to Factory Defaults and place it 
in the same subnet as the TalkMaster Focus Server 
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Searching the IP Endpoint List 

To search for a specific IP Endpoint, select menu option Search --> Search IP Endpoint List or press 
the ctrl+f keys.  The following dialog will be open: 

Enter any part of a Location Name, ICOM ID or IP Address and then click the Prev or Next button. 

Checking the Match Case option will limit the search to characters that have the same case as entered 
into the Find what: option  
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Menu Options 

File Menu Options 

The File menu has the following option: 

 Exit - exits the Firmware Console session

Search Menu Options 

The Search menu has the following option: 

 Search IP Endpoint List - opens the Search IP Endpoint List dialog to search IP Endpoints by
any part of the Location Name, ICOM ID or IP Address

 This will search for a match within the IP Endpoint's Location Name, IP Address and
ICOM ID (even if the field is not displayed in the list box)

 The search will automatically wrap when it reaches the end of the list

 Enter the string to search for and click either the FIND PREV or FIND NEXT button

 The dialog can stay open and be repositioned while other options are used

 A history of the previous ten searches made can be selected from the Find what: drop
down arrow

Tools Menu Options 

The Tools menu has the following option: 

 Record program events to file - Checking this option records tracking information about the
operation of the Firmware Console.  It should used if instructed by Technical Support

 Open Support Folder - This option opens the folder where the tracking information is stored

Help Menu Options 

The Help Menu has the following options: 

 About - displays the current software version
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Support Information 

Contacting Technical Support 

For Information on contacting Technical Support, please visit our web site at: 

www.digitalacoustics.com 

About Us 
Digital Acoustics, LLC 
www.digitalacoustics.com 

  

Digital Acoustics®, TalkMaster Focus®, ii3®, IP7®  and UBAM®  are trademarks of Digital Acoustics 
LLC. All other marks used are properties of their respective owners. Digital Acoustics' product designs are 
packaged by leading manufacturers around the world. 

©  2007 - 2019 Digital Acoustics, LLC 

All Rights Reserved 

https://www.digitalacoustics.com/support
https://www.digitalacoustics.com/
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Notes 
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